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Activity Overview 
In this activity, as one point changes, a corresponding point changes according to a mathematical 
relationship between the two points. By observing the patterns, you will write a rule that describes the 
mathematical relationship. 
 
 
 

As you move point Z in each of the following pages, point W moves 
according to some mathematical rule.  

For each of the six problems, answer the following questions. 

 

 
1.  If the coordinates of Z are given by (a, b), predict the coordinates of W. Justify your reasoning. 

(Note: You might want to answer some of the questions provided at the end of this activity to 
understand a new rule.)  

 
2.  How does your prediction compare to someone else’s prediction? 

 
3.  Describe the strategy you used to determine the rule. 

 
4.  If possible, describe a geometric transformation under which point W is the image of point Z 

(i.e., translation, rotation, reflection, rotation, dilation, projection). Can you use more than one 
transformation to describe the relationship? Why or why not? 

 
To find the rule you might explore the following questions. 

a.  In what quadrant is W if you move Z to the first quadrant? second? third? fourth?”  

b.  What happens if Z is on the x-axis? y-axis? the origin? 

c.  Is it possible to get W in the first quadrant? second? third? fourth? If so, where must Z be located 
in each case? 

d.  Is it possible for W to be on the positive x-axis? negative x-axis? positive y-axis? negative y-axis? 
the origin? If so, where must Z be located (in each case)? 

e.  Is it possible for Z and W to be in the same quadrant? 

f.  Is it possible for Z and W to coincide? 

g.  If you move Z horizontally to the right (or along some other described path and direction), how 
does W move?” 

 

5



 

This page intentionally left blank 

 

6



 CCSS Mathematical Practices 
TI PROFESSIONAL DEVELOPMENT 

 

©2013 Texas Instruments Incorporated 1 education.ti.com 

The eight core practices that students should understand and enact in doing and thinking about 
mathematics: 

1. Make sense of problems and persevere in solving them 
2. Reason abstractly and quantitatively 
3. Construct viable arguments and critique the reasoning of others 
4. Model with mathematics 
5. Use appropriate tools strategically 
6. Attend to precision 
7. Look for and make use of structure 
8. Look for and express regularity in repeated reasoning 

 
In particular: 

1. Make sense of problems and persevere in solving them 
• consider analogous problems, special cases and simpler forms  
• transform algebraic expressions or change the viewing window to obtain information needed 
• use concrete objects or pictures to help solve a problem 
• explain correspondences between equations, verbal descriptions, tables, and graphs or draw 

diagrams of important features and relationships, graph data, and search for regularity or trends 
• make conjectures about the form and meaning of the solution and plan a solution path rather than 

jumping into a solution 
• check answers to problems using a different method 
• monitor and evaluate progress and change course if necessary 
• understand and compare different approaches 

 
2. Reason abstractly and quantitatively 

• represent a given situation symbolically and manipulate the representing symbols 
• stop and think about what the symbols represent in the context of a given situation 
• reason with quantities and about relations among quantities 
• consider the units involved 
• attend to the meaning of quantities, not just how to compute them 
• know and flexibly using different properties of operations and objects 

 
3. Construct viable arguments and critique the reasoning of others 

• make conjectures and build a logical progression of ideas 
• use stated assumptions, definitions and previously established results in constructing arguments  
• determine domains to which an argument applies 
• analyze situations by breaking them into cases 
• recognize and use counterexamples 
• compare the effectiveness of two plausible arguments 
• distinguish correct reasoning from that which is flawed and explain any flaws 
• justify conclusions and communicate them to others 
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4. Model with mathematics 
• write an equation to describe a situation 
• apply mathematics to solve problems arising in everyday life, society, and the workplace 
• identify important quantities in a practical situation and map their relationships using diagrams, 

two-way tables, graphs, flowcharts and formulas 
• make assumptions and approximations to simplify a complicated situation 
• interpret mathematical results in the context of the situation and reflect on whether the results 

make sense, improving the model as necessary 
 
5. Use appropriate tools strategically 

• make sound decisions about using tools, recognizing both the insight to be gained and their 
limitations 

• use technology to visualize the results of varying assumptions, explore consequences, and 
compare predictions with data 

• use technological tools to explore and deepen understanding of concepts 
• identify relevant external mathematical resources and use them to pose or solve problems 
• analyze graphs, functions and solutions generated by technology 
• detect possible errors by using estimation and other mathematical knowledge 

 
6. Attend to precision 

• communicate precisely to others 
• use clear definitions in discussion and in reasoning 
• state the meaning of symbols used, specifying units of measure, and labeling axes 
• calculate accurately and efficiently 
• note the assumptions made 
• express answers with an appropriate degree of precision 

 
7. Look for and make use of structure 

• look closely to discern a pattern or structure 
• see complicated things (such as algebraic expressions or functions or a histogram) as single 

objects or being composed of several objects 
• recognize and use the strategy of drawing auxiliary lines to support an argument  

 
8. Look for regularity in repeated reasoning 

• notice if calculations are repeated 
• look for general methods and for shortcuts  
• evaluate the reasonableness of intermediate results 

 
 
 
Common Core State Standards for Mathematics. (2011). 
www.corestandards.org/assets/CCSSI_Math%20Standards.pdf 
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Activity Overview 
Find evidence of students engaging in the Mathematical Practices. 
 
 
 
 

Observation Mathematical Practice 

 

 

 

 

• How did the video help convey what the Mathematical Practices look like in the classroom?  
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Open the TI-Nspire™ document The_Painted_Cube.tns. 
 
A cube with dimensions n × n × n that is built from unit cubes is 
dipped in a can of paint. You will model the relationships between the 
dimensions of a cube and the number of faces of the unit cubes that 
are painted. 
  

 
Part 1—Introduction to the Problem 
 
Move to page 1.2. 
 

Press / ¢ and / ¡ to 

navigate through the lesson. 

One strategy for solving a problem is to solve a simpler related problem. 
1. Consider a 2 × 2 × 2 cube.  

 a. How many unit cubes does it take to build a 2 × 2 × 2 cube? 
 
 
 
 b. Rotate the model on page 1.2 by dragging the open points on the left side of the screen. 

If needed, build your own model using cubes. If this cube were dipped in paint, what is 
the greatest number of faces of a single unit cube that could be painted? 

 
 c.  How many faces of each of the unit cubes are painted on the 2 × 2 × 2 cube? 

 

 
Move to page 2.1. 
 
2. Now consider a 3 × 3 × 3 cube. 

 a.  How many unit cubes does it take to build a 3 × 3 × 3 cube? 
 

 b. Rotate the model on page 2.1 by dragging the open points on the left side of the screen. 
If needed, build your own model using cubes. If the 3 × 3 × 3 cube were dipped in a can 
of paint, how many faces of each of the unit cubes would be painted? 
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3. a.  Record your findings for the 2 × 2 × 2 and 3 × 3 × 3 cubes in the table below. Then 
 determine how many faces of each of the unit cubes would be painted for the  

  4 × 4 × 4 and 5 × 5 × 5 cubes if the large cubes were dipped in paint. 
 

n 
(side length 

of cube) 

Number of unit 
cubes with paint 

on zero faces 

Number of unit 
cubes with paint 

on one face  

Number of unit 
cubes with paint 

on two faces 

Number of unit 
cubes with paint 
on three faces 

2     

3     

4     

5     
 

  

b.  What patterns do you notice in the table? 

 

 

 

Part 2—Investigating Paint on Three Faces  
 
Move to page 2.2. 
 
You will now analyze the data you collected and explore the relationships graphically for a cube 
with any side length n. You will then use the graph to make predictions for the case where n = 10. 

 
Move to page 3.1. 
 

4. Enter the values from your table above into the spreadsheet on page 3.1. 

 

5. From the information in the table, how many unit cubes would have paint on three faces in a 
10 × 10 × 10 cube? Explain your reasoning. 
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Part 3—Investigating Paint on Two Faces  

 
Move to page 3.2. 

 
This page uses the data that you entered on page 3.1 to make a scatter plot of the number 
of unit cubes with paint on two faces versus the side length of the cube, n. 

6. Describe the relationship between the two variables.  

 

7. Add a movable line by selecting Menu > Analyze > Add Movable Line.  

 a. Grab the line and transform it to get a line of best fit. What is the equation of your line of best fit? 

 

 b. Test your equation with known values from your table and adjust your movable line 
as necessary. Once your equation matches the known values, what is the equation 
of your line? 

 

 c. Write your equation in factored form. What is the meaning of this form of the 
equation in the context of the painted cube problem? 

 

 

8. Use your equation to determine the number of unit cubes that would have paint on two 
faces in a 10 × 10 × 10 cube. 

 

9. Explain how your answer makes sense in terms of the graph on page 3.2. 

 

Part 4—Investigating Paint on One Face  

 
Move to page 3.3.  

 
This page uses the data that you entered on page 3.1 to make a scatter plot of the number 
of unit cubes with paint on one face versus the side length of the cube, n. 

10. Describe the relationship between the two variables. 

 

 

 

13



  The Painted Cube Name   
Student Activity Class   

 

©2013 Texas Instruments Incorporated 4 education.ti.com 

11. Determine the equation of the curve of best fit. Press Menu > Analyze > Regression 
and select the type of function that you think will best fit the data. 

 a.  What is the regression equation? 

 

 b.  Test your equation with known values from your table. If needed, choose a different 
type of regression equation. Once the equation matches the known values, what is 
the equation? 

 

 c. Write your equation in factored form. What is the meaning of this form of the 
equation in the context of the painted cube problem? 

 

 

12. Use your equation to determine the number of unit cubes that would have paint on one 
face in a 10 × 10 × 10 cube. 

 

Part 5—Investigating Paint on Zero Faces  

 

Move to page 3.4. 

 

This page uses the data that you entered on page 3.1 to make a scatter plot of the number 
of unit cubes with paint on zero faces versus the side length of the cube, n. 

13. Describe the relationship between the two variables. 

 

14. Determine the equation of the curve of best fit. Press Menu > Analyze > Regression 
and select the type of function that you think will best fit the data. 

 a.  What is the regression equation? 

 

 b.  Test your equation with known values from your table. If needed, choose a different 
type of regression equation. Once the equation matches the known values, what is 
the equation? 

  

15. Use your equation to determine the number of unit cubes that would have paint on zero 
faces in a 10 × 10 × 10 cube? 
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Part 6—Reflecting on the Problem 

16. a. Record the type of relationship (e.g., linear, quadratic) for each of the numbers of 
 painted faces you investigated. 

 

Painted Faces Type of Relationship 

3  

2  

1  

0  

 

 b. Think about the painted cubes and how the numbers of painted faces change as 
the side length of the cube, n, increases. Justify why each type of relationship 
makes sense in the context of the problem. 
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Understanding student thinking provides essential information for helping students learn. The only 
reasons to ask questions are: (Black et al., 2004) 
 
To PROBE or uncover students’ thinking  

• Understand how students are thinking about the problem.  

• Discover misconceptions.   

• Use students’ understanding to guide instruction.  

 
To PUSH or advance students’ thinking 

• Make connections. 

• Notice something significant.  

• Justify or prove their thinking.  

 
The activity:  A cube with dimensions n × n × n that is built from unit cubes is dipped in a can of paint. 
How many unit cubes have paint on zero, one, two and three faces?  Model the relationships between the 
side length of a cube (n) and the number of unit cubes with paint on zero, one, two, and three faces. The 
complete activity is available at education.ti.com > Activities > Math Nspired > Algebra 2 > Polynomials. 
 
Explore the cube models on page 1.2 and 2.1.   Rotate the model by dragging the open points on the left 
side of the screen. 
 

          
 
A slight tweak in a question can change the information a teacher can learn from the response.  What is 
the difference between the questions below? 

• What would the graph of the relationship between the side length of a cube and the number of 
unit cubes with 2 faces painted look like? Why? 

• What kind of pattern would you see that would produce a graph that has a constant rate of 
change? Explain your reasoning. 

17
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Consider the following questions in terms of student responses they are likely to elicit. 
What would those responses indicate about how students were thinking? 

  

1. Which of these might actually probe or uncover student thinking? 

• Predict the total number of unit cubes it takes to build a 2 × 2 × 2 cube?  A 3 × 3 × 3 cube? 

• How many faces of each of the unit cubes is painted on a 2 × 2 × 2 cube? 

• As you increase the side length of the cube, what happens to the number of cubes with zero 
painted faces? One painted face? Two painted faces?  Three painted faces? 

• What does the x-axis represent in a graphical representation? 

• What are the intervals on the x and y-axis? 

• Is the length of the cube the dependent or independent variable? 

 

2.  Which of the following might actually push or advance student thinking?  

• Explain the relationship between domain and range that cause the function to be linear vs. 
exponential. 

• What math concepts do you think these patterns will address? 

• How do the graphs differ for zero, one, two, or three painted sides?  

• Justify why each type of relationship makes sense in the context of the problem. 

• How is the algebraic model for each of these graphs related to the picture of the cube? 

 

References 

• Black, P. Harrison, C., Lee, C., Marshall, E., & Wiliam, D. (2004). “Working Inside the Black Box: 
Assessment for Learning in the Classroom,” Phi Delta Kappan, 86 (1),  9-21. 
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Activity Overview 
In this activity, you will examine two vignettes that model classroom discussions about equations with 
variables on both sides. By analyzing the structure, content, and product of each discussion, you will 
identify specific teacher moves that probe for student understanding and push student thinking. 
 

 
Mr. Ryan’s Class 

1. Read through the transcript of Mr. Ryan’s class and respond to the following questions. Use the 
transcript to provide evidence. 

a. How do Mr. Ryan and his students interact with each other during the discussion? 

 

 

b. Which instructional moves probed student understanding? 

 

 

c. Which instructional moves pushed student thinking? 

 

 

d. Which instructional moves didn’t probe student understanding or push student thinking? 

 

 

2. Watch the video clip of Mr. Ryan’s class.  

a. Which Mathematical Practices were supported by the discussion? 

 

 

b. What evidence of student understanding was produced from the discussion? 
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Mr. Craig’s Class 

3. Read through the transcript of Mr. Craig’s class and respond to the following questions. Use the 
transcript to provide evidence. 

a. How do Mr. Craig and his students interact with each other during the discussion? 

 

 

b. Which instructional moves probed student understanding? 

 

 

c. Which instructional moves pushed student thinking? 

 

 

d. Which instructional moves didn’t probe student understanding or push student thinking? 

 

 

4. Watch the video clip of Mr. Craig’s class.  

a. Which Mathematical Practices were supported by the discussion? 

 

 

b. What evidence of student understanding was produced from the discussion? 

 
 
 
5. What differences in mathematical understanding emerged between the two classrooms? 
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1. Teacher: Yesterday we learned how to solve an equation with variables on both sides, and I gave 
everyone a problem to work on for homework. We have it written here on the board: 2 times the 
quantity 2x plus 5 equals 6x minus 2. I don’t want to show us how to do this, but I would like 
someone to walk us through the process. So, any volunteers? 

2. Student (Amy): Sure, I’ll do it. 

3. Teacher: Great, Amy. Where did you begin? 

4. Student (Amy): First, I multiplied through by 2 on the left, and then I moved all the variables to one 
side. 

As Amy describes her first step, Mr. Ryan writes it on the board: 

2(2x+5) = 6x – 2 

4x + 10 = 6x – 2 

5. Teacher: Great. What did you subtract first? 

6. Amy: I subtracted 4x from both sides. 

Mr. Ryan writes Amy’s next step on the board: 

4x + 10 = 6x – 2 
                                                               -4x           -4x 

       10 = 2x – 2 

7. Teacher: Why did Amy do that, class? 

8. Student #2: To cancel out a variable? 

9. Teacher: Ok, and why do we want to cancel out a variable? 

10. Student #2: To make it look easier? 

11. Amy: To get the variable alone on one side. 

12. Teacher: Ok. That’s great. We’ve got the variable terms alone on one side—what does the 
resulting equation look like? 

13. Student #2: It has a number on the left, and a number and a variable on the right. 

14. Teacher: Can anybody restate that using vocabulary words? 

15. Amy: It has a constant term on the left, a variable term on the right, and a constant term on the 
right. 
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16. Teacher: That’s great. Now, both observations are correct, but vocabulary words make it more 
precise. Where do we go from here? 

17. Amy: I added 2 to each side to get the number, or the constant term, on the left and the variable 
term on the right. 

Mr. Ryan writes Amy’s next step on the board: 

10 = 2x – 2 
+2          +2 

                                                                      12 = 2x 

18. Teacher: So we’re finished, right? 

19. Amy: No, now we need to divide both sides by 2 so x equals 6. 

Mr. Ryan writes Amy’s next step on the board: 

12 = 2x 
2      2 

6 = x 

20. Teacher: So now we’re finished. Right? 

21. Student #2: No, now we need to check our answer. 

22. Teacher: Ok. And how do we check our answer? 

23. Student #2: By plugging it in. 

24. Teacher: Did anyone start off differently? 

25. Student #2: I subtracted 6x from both sides instead of 4x. 

26. Teacher: Did you get the same answer? 

27. Student #2: Yes. 

28. Teacher: So it doesn’t matter what step we begin with first as long as we do those steps properly, 
we should get the same answer. 

29. Student #3: But I divided both sides by 2 to start out with. 

30. Teacher: Ok, that’s good. But usually we want to simplify first when we’re solving an equation. 
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1. Teacher: Hello, class. Yesterday, we looked at how to solve an equation with variables on both 
sides. And I gave you an equation for homework. It was as follows here on the board. 2 times the 
quantity 2x plus 5 equals 6x minus 2. Now, before we start into it, I want to just again ask a 
question to start us thinking about this: What is an equation?  

2. Student #1 (Nancy): Something with an equals sign in it. 

3. Teacher: So what are we looking for then when we try to solve an equation? 

4. Nancy: The answer. 

5. Teacher: Ok. So what makes it the answer? How do we know the number is a solution to an 
equation? 

6. Nancy: Because when we check it by plugging it in to the equation, it’s true. 

7. Teacher: All right. Good. Then let’s talk through then this process of solving an equation. Any 
volunteers? 

8. Student #2 (Amy): Sure, I’ll do it. 

9. Teacher: Great. Thanks, Amy. So how did you start? 

10. Amy: Well, first I multiplied by 2 on the left side. 

11. Teacher: Ok. Multiplied by 2, good. [He writes “multiplied by 2” on the board.] And?  

12. Amy: And then I moved all the variables to one side. 

13. Teacher: And how did you do that? 

14. Amy: I subtracted 4x from both sides. 

15. Teacher: Ok, so then you subtracted 4x. And that was from both sides. [He writes “subtracted 4x 
from both sides” under “multiplied by 2.”] So there was one possible. Anyone else? 

16. Nancy: I subtracted 6x from both sides. 

17. Teacher: So that was your first step Subtracted 6x from both sides. [He writes “subtracted 6x from 
both sides.”] All right. Anyone else?  

18. Student #3 (Pat): I divided both sides by 2. 
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19. Teacher: Ok, so divided both sides by 2. [He writes “divided both sides by two.”] All right. So at this 
point, we’ve got 3 different possible ways to start. We had Amy who subtracted 4x at first. Then we 
had Nancy who was subtracting 6x, and then we had Pat who divided both sides by 2. Now, the 
question for you class, is this going to affect our solutions? If you think they’re going to get the 
same answer, raise your hand. Ok. Now, those who think you’re going to end up with different 
answers depending on how you started, raise your hand. All right, well, we’ve got people on both 
sides of the question. So let’s take a couple minutes and discuss your predictions amongst 
yourselves within your groups. 

Scene 2 

20. Teacher: Ok, I’d like everyone to focus again up at the front. Who was surprised by the outcome?  

21. Amy: I was. I thought the answers would be different because we subtracted different things first. 

22. Teacher: All right. Well, that didn’t happen, did it? If your prediction was correct then, tell us what 
you were thinking.  

23. Nancy: So my prediction was right. I figured that since an equation only has one answer, we’ll get 
there no matter what we subtract first. 

24. Teacher: So, all equations then have just one solution? 

25. Nancy: Right. 

26. Pat: Wait a second. We solved an equation yesterday that had no solutions.  

27. Nancy: Yeah, and another one that had all numbers as solutions. 

28. Amy: Oh, yeah, I remember that. But these equations look different after we took different first 
steps. 

29. Teacher: So not all equations have one solution? But Amy has an interesting point. If there’s a 
different first step, then will the solution be different? Well, let’s get back into our groups for three 
minutes and let’s formulate an answer to Amy’s question. Will the solutions be different if you have 
a different first step? 
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Activity Overview  
Provide students opportunities to engage in the Mathematical Practice “look for and make use of 
structure”. 
 
 
 
 

1. Solve for x: . 

 

 

 

2. Solve for x: . 

 

 

 

3. Solve for x:
 

. 

 

 

 

4. Evaluate: . 

 

 

 

5. Solve for x: . 

 

6. Solve for x: .  
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7. Given that AE=6 cm and ABCD is a rectangle inscribed in a quarter 
circle, what is the length of BD in cm? 

 
8. What is the area in cm2 of a square with a diagonal of 10 cm?  

9. Given a∥b, m 1=120°, and m 2=50°. What is m 3 in degrees? 

 

10.  

 

 

11.  
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Activity Overview 
This activity describes how to generate a graph of two-variable data already entered into a Lists & 
Spreadsheet application using Quick Graph and analyze the data using a movable line and least squares 
regression to explore the relationship between the variables. 

 
 

Step 1: Opening the Document 

1. Press c. Select My Documents. Open the document 

entitled Movable_Line.tns. 

2. Proceed to page 1.2, press the / and ¢ key on the 

Touchpad and you will see Lists & Spreadsheet page with 
data in both Columns A and B.  

  
Step 2: Graphing a Scatter Plot Using Quick Graph 

1. To make a scatter plot of the data (alt,temp),select both lists. 
Place the cursor in a cell in the alt column. Continue to press 
the £ key until the entire list is highlighted. 

Press and hold g, and press the ¢ key to move to the right 
and highlight both lists. Release the g key. 

  

2. Select Menu > Data > Quick Graph. 

The screen will automatically split vertically—the Lists & 
Spreadsheet application remains in the left work area while a 
Data & Statistics application is inserted in the right work area. 
A scatter plot appears.  

When the Quick Graph option is chosen, a scatter plot is 
created with the first list selected as the independent variable.  

 

Note:    The dark rectangle around the Data & Statistics application work area indicates that 
the application is active. To move from one work area to another, press / e or 
use the Touchpad and press a to select the desired application. 
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Step 3: Another Method of Graphing Data from a Spreadsheet:  
Using a Data & Statistics page with the data (alt, temp) entered in 
a spreadsheet 

1. Press / ~ and insert a Data & Statistics page. 

2. Press e and select alt for the variable along the horizontal 

axis. 

3. Press e and select temp for the variable along the vertical 

axis. 

 

 

Step 4: Exploring the relationship between the variables:  
Adding a movable line 

1.  Return to page 1.2 and select Menu > Analyze > Add 
Movable Line. A line will appear on the screen. 

 

2.  Move your cursor until it is near what appears to be the end of 
the line. A é will appear. Press / x to grab the line and 
rotate it. Press d or x to release the line. 

3.  Move your cursor until it is near what appears to be the middle 
of the line. A ö will appear. Press / x to grab the line and 
move it horizontally and vertically. Press d or x to release 

the line.  

4.  Move the line until you think it best represents the pattern of the 
data. Press d.  
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Step 5: Finding the least squares regression line 

1.  Proceed to page 1.3 with the data plotted.  

2.  Calculate the least squares regression line by selecting Menu > 
Analyze > Regression > Show Linear (mx+b). 
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1. Shawn:  Linear, but I’m not sure. 

2. Teacher: What about the data looks linear to you? 

3. Student #1: The temperature is directly increasing. 

4. Shawn: Yeah. Ok, nevermind. My bad. 

5. Teacher: Reese? You disagree? 

6. Reese: Yeah. 

7. Teacher: Why? 

8. Reese: Because it’s an inverse. 

9. Teacher: What do you mean, it’s inverse? 

10. Reese: Cause, I don’t know. 

11. Teacher: What do you mean? What do you mean it’s inverse? 

12. Gurerra: The relationship . . . 

13. Reese: Yeah, the relationship between x and y are opposite direction. 

14. Teacher: So, it’s inversely proportionate? Ok, let’s talk about that in our groups. Ok? Do you think it’s 
a linear relationship? Or Reese has put out that it’s inversely proportional. 

15. Students: I agree…Inverse? 

16. Student #3: I think it’s inversely related. 

17. Reese: You said it was linear! 

18. Teacher: I don’t know. Talk about it in your groups. What kind of relationship? 

19. Student #2: No, I said it was inverse. It’s an inverse relationship. 

20. Reese: That’s what it would look if it was exponential. 

21. Student #4: Yeah, inverse variation is exponential. Right?  And direct is linear. 

22. Reese:  Yeah. Come on Shawn. Wake up. 

23. Student #4:  If Reese is saying it’s inverse . . .it wouldn’t be linear. 

24. Gurerra: But it’s not. 

25. Reese: What is that. . . ? I know. I got the same thing. 

26. Student #4: Yeah, I just yeah. They’re all one graph. 

27. Student #5: Ok they just spread out more as you move down, right? It’s not a constant change. 

28. Student #4: Could it be considered linear if it was constant change? 
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29. Teacher: Ok, Gurerra, what did your group come up with? 

30. Gurerra: We don’t think that it’s like proportional or all that because if the dots are spreading out 
more as you go down, then how would you keep it the same? 

31. Student #5: There’s not a constant change. 

32. Teacher: There’s a constant rate of change? 

33. Students: No. 

34. Teacher: No, there isn’t a constant rate of change. 

35. Students: Yeah. 

36. Teacher: Ok, and what tells you that based on the data? 

37. Gurerra: ‘Cause the dots start spreading out more the farther you go. 

38. Student #6: Yeah. Starts out very close and then goes [click, click, click]. 

39. Teacher: What do you mean, the dots? 

40. Student #6: The points. 

41. Gurerra: On the graph. 

42. Teacher: Oh, you guys made a graph of it. Let’s take a look at it. What about the graph helps us to 
take a look at the data a little more closely? 

43. Raez: The shape of the plot on the graph. 

44. Teacher: OK, so the shape. What can the shape tell us? Ok, so Gurerra, let’s look at yours. 

45. Gurerra: If it’s linear. 

46. Teacher: OK, so Gurerra, let’s look at yours. 

47. Student #6: How did people get graphs like that? 

48. Student: Oh, yeah, the units are different. 

49. Teacher: Ok. Guys, quiet please. Gurerra, let’s talk about your graph. What did you see? 

50. Gurerra: The higher up you are then the more closer the dots are to each other. But then as you go 
down. . . as you go up, then the space in between them increases. 

51. Teacher: So how did you arrange your graph? What is the x-axis? 

52. Gurerra: That’s the altitude. 

53. Teacher: Ok. Which would make the y-axis what? 

54. Gurerra: The temperature. 

55. Teacher: The temperature. Ok. So what can we see? 
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56. Students: The higher up you go . . . linear. . . 

57. Teacher: It’s linear? 

58. Students: It looks linear. 

59. Gurerra: But the higher you go, you’re spreading out the more and it’s linear. 

60. Many voices 

61. Teacher: Raez, what did you say? 

62. Raez: Doesn’t it depend on the rule because if you plus or minus or something, you take the lead . . . 

63. Teacher: Ok, good. So if we’re adding or subtracting from it . . . She said, ‘what if you filled in.’ What 
does that mean to fill in the points in between?  

64. Student #6 and other voices: You get every single point in altitude. 

65. Teacher: Ah, so do you think if we had different altitudes, what could we say? I’m going to put you 
back in your groups. If we starting plugging in different altitudes for this data, what do you think it 
would look like versus the graph that we have. Talk about it in your groups. If we started plugging in 
different altitudes . . . 

66. Gurerra: So it could be linear then! 

67. Student #8: Even if it’s not a straight line, it would still be the same distance as this one. 

68. Student #9: But they are just jumping. . .  

69. Student #8: See, ‘cause isn’t inverses the one increases and the other decreases? So then, this 
looks linear, but it’s inverse because the points are farther apart as you get higher. 

70. Student #9: Yeah, But like, for the altitude what happens is they don’t make a constant . . . they’re 
just jumping around for different numbers, so that’s going to make the temperature just jump around 
too. 

71. Student #8: But if we plugged it in . . . 

72. Student #9: So if we went from the even numbers from like 5, 10, 15, 20, it should show that there’s 
a constant change. 

73. Student #8: We plug that in, how do we go left? 

74. Gurerra {in the background}: You don’t know the relationship between x and y, how can you know 
that they’re linear. It would be great if we had the rule. 

75. Student #8: I think it is linear. 

76. Student #9: Do we start over again? 
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Activity Overview 
Engage in the Mathematical Practice “look for and express regularity in repeated reasoning” by exploring 
systems of equations. 
 
 
 

Materials 
• Systems_of_Equations.tns 

 
 
 
 

On page 1.2 of the TI-Nspire™ document, use the Solve command to find the solution to the system. 

x+2y=3 

4x+5y=6 

 

Move to page 1.3. Use the Solve command to find solutions to other systems of equations that have 
something in common with the system shown above. Look for patterns and make conjectures about any 
connections or relationships you notice. Test your conjecture with other examples.  

 

 

 

 

Expand your conjecture to see what happens if you change the equations with respect to new patterns.  

  

 

 

 

 

See if you can generalize and prove your results. 
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Activity Overview 
Engage in the Mathematical Practice “look for and express regularity in repeated reasoning” by exploring 
number relationships. 
 
 
 

Materials 
• Number_Relationships.tns 

 
 
 
 

Choose two positive integers a and b where a>b and compute the following: a2-b2, 2ab, a2+b2. Repeat the 
process with several other pairs of integers. You may use the Scratchpad on the TI-Nspire handheld for 
your calculations. Compare your values to those obtained by other participants. Make a conjecture about 
the numbers, and then try to prove your conjecture.  

 
 
 
 
 
 
 
 
 
 

 

Move to page 1.2 of the TI-Nspire™ document. Enter values for a and b into the spreadsheet. Describe 
the patterns you see in the three columns to the right. Make a conjecture about one of the patterns and 
try to prove your conjecture. 
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Questioning 

• Be relentless in asking what does it mean and why does it work 
• Wait after asking a question before calling on a student and before reacting to a student answer 

to a question 
• Deflect questions to students 
• Expect and create opportunities for full participation from all students 

 
Discussion 

• Orchestrate productive discussion among students 
• Activate the five strategies for managing a discussion: anticipate responses, monitor student 

work, select work to be presented, sequence student responses in meaningful way, connect 
responses to the mathematical goals of the lesson 

 
Formative Assessment 

• Engage students in defending responses to peers 
• Celebrate wrong answers as places to learn, promoting discussions about what is good about 

wrong answers and why they are wrong 
• Engage students in providing feedback to one another 
• Be relentless in focusing on what students are thinking about the mathematics 

 
Tasks 

• Tasks should have a worthwhile mathematical objective. 
• Choose or frame tasks in ways that allow opportunities for discussion 
• Establish and maintain the cognitive demand of tasks by the questions posed and interventions 

that support student reasoning 
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Activity Overview 
This activity describes the steps for the construction of two sliders. The sliders will be used to control the 
parameters in the function f(x) = a · x + b.   
 
 
 

Step 1: 

Press c and select New Document to start a new 

document. Select Add Graphs. 

 

Step 2: 

The cursor will be in the entry line to the right of f1(x) =.  

Type a · x + b by pressing A r X + B. Press ·.  

Note:   The function is not graphed in the graphing window since 
the values of the parameters (a and b) have not yet been 
assigned. 

 

 

Step 3: 

Insert a slider by selecting Menu > Actions > Insert Slider. 

 

Step 4: 

Use the Touchpad to move the slider to the upper-left corner of the 
screen and then press x or ·. The current slider variable name 

v1 is highlighted. Type over the name of the variable by pressing the 
letter A (a parameter in the entered function). 

Press ·.   
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Step 5: 

Repeat Steps 3 and 4, pressing the letter B for the variable name 

of the slider.  

Press ·. The graph of the linear function should now be visible 

in the graphing window. 

 

Step 6:  

To change the value of the parameter, use the Touchpad to 
move the cursor over the slider controller. When an “open hand” 
(÷) appears, press / x to grab the slider controller. Drag 

the slider controller using the Touchpad to change the value of 
parameter b. Observe the effect on the graph of the line. 

 
 

Step 7:  

A slider can be horizontal, vertical, or minimized. To minimize a 
slider, move the cursor over the slider and press / b to 

display the context menu. Select Minimize. To change the value 
of the variable, click on the right or left arrow key. 

  

Step 8: 

To change the settings for a slider, move the pointer over the 
slider, and press / b to display the context menu. Select 

Settings. 

  

 

Step 9: 

To change the slider settings, press e to move to the desired 

field, and type in the new setting value. Change the settings to 
match the screen at the right. Press · or click on OK to close 

the slider settings dialog box. Repeat Steps 8 and 9 to change 
the settings for the other slider. 

 
 

\ 
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1. Teacher: Now, here’s what I want. I want you to play around with your sliders. What I want you to do 
is each group has to come up with three observations or questions. Ok? So play around with them, 
discuss, come up with three observations or questions. Ok, go to it. 

2. Teacher: Zach, what did your group find out? What did you discuss? 

3. Zach: If you slide the B, it changes the location on the x and y-axis. 

4. Teacher: When you slide B? 

5. Zach: Yeah. And the A, just rotates. It keeps, I think, yeah, the y-axis on the same point. But changes 
the x-axis. 

6. Teacher: What do you mean? Show us what you’re talking about. 

7. Zach: Here. So this is a. 

8. Teacher: And what’s happening? 

9. Zach: It just keeps the same point on the y-axis, but it changes the x. 

10. Student #2: The same intercept. 

11. Zach: Yeah. 

12. Teacher: Ok, but you mentioned something. What is it doing? 

13. Zach: It’s rotating. 

14. Teacher: Is that true? 

15. 2 Students answer: Yeah. 

16. Teacher: It’s rotating. 

17. Student #2: Around its y-intercept. 

18. Teacher: Ok, what’s the center of rotation? 

19. Several voices plus Teacher: The y-intercept. 

20. Teacher: Interesting. But how do you know that? I can’t see the y-intercept up there. How do you 
know it’s rotating around the y-intercept? 

21. Student #3: ‘Cause of the sliders. 

22. Teacher: What? 

23. Student #3: Doesn’t the sliders show you it? 

24. Teacher: Wait, Wait. Hold on. Forget about the sliders. Don’t move the sliders. Go back. Go back. 
How do you KNOW that it’s rotating around the y-intercept without even seeing it? 
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25. Student #4: Because b is the y-intercept and we’re not changing b. So we can’t change the y-
intercept, so it has to stay intercepting the y at that point. 

26. Teacher: Right, at that point, we’re not changing that point. So that’s stationary, isn’t it? So we know 
that it’s rotating around the y-intercept. So the y-intercept is the center of rotation. Good! Good! What 
else do you notice when you move the slider for a? Let’s go to somebody else. Nisa, what do you 
notice? 

27. Nisa: That it will, it adjusts to either positive or negative. 

28. Teacher: What does that mean? 

29. Nisa: Well, if you move the slider to the negative side, the whole line will shift, will rotate, to the 
negative range. 

30. Teacher: Ok, what does that mean? How do you know that it’s in the negative range? What about the 
line tells you it’s in the negative range? 

31. Nisa: It shows it? 

32. Teacher: What do you mean? How does the line show that it’s a negative slope? 

33. Nisa: The coordinates on the line are either positive or negative. 

34. Teacher: Is this line negative? Yep? But this has a positive x-coordinate (pointing to screen). 

35. Nisa: But it’s intersecting at a negative coordinate. 

36. Teacher: Ok, but that’s for the y-intercept, right? That’s b. What happens when we change a? 

37. Nisa: Then it rotates. 

38. Teacher: It rotates, good. What else do we notice? I mean I want to talk…Yes, Kai. 

39. Student #5 (Kai): The slope stays the same, if you move a. 

40. Teacher: The slope stays the same, if we move a? 

41. Many voices: No, no. 

42. Teacher: Does it? Do you disagree? 

43. Zach: It seems like the..yeah..the slope changes. 

44. Teacher: What? It changes. How does it change? How does it change? How does the slope change? 
Uh, Kaliwell. 

45. Student #6 (Kaliwell): How does the slope change?  

46. Teacher: Yeah. 

47. Kaliwell: Well, either the rise or the run change. I guess? 

48. Teacher: I don’t know what that means. Ok, let’s look at that line right there. 
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49. Kaliwell: Ok. 

50. Teacher: What kind of slope is that? 

51. Some voices: Positive slope. 

52. Some voices: Negative slope. 

53. Teacher: How do you know it’s negative? 

54. {Some inaudible as multiple students answer.} 

55. Student #7: It’s going to the left. 
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1. Teacher: Ok, let’s mess around with the b slider. Actually, you know what? What are some other 
observations that you folks made? Did anybody make any other interesting observations? 

2. Frank: My line looks strange. 

3. Teacher: Ok, Frank’s line looks strange. Let’s look at Frank’s line real quick. Whose was that? Is it 
the same one you had before? 

4. Frank: Yeah. 

5. Teacher: Ok.  

6. Frank: Except I changed the color. Right there in the corner.  I’ll zoom out.  

7. Teacher: Ok. Hold on a second. 

8. Frank: I’m going to zoom out, ok? 

9. Teacher: Oh, he did a different equation? That’s why? 

10. Frank: I did multiple…Yeah. I know, but I wanted to try it.  

11. Teacher: Wait. Hold on a second.  Hold on a second. He did division. That’s why that looks like that? 

12. Frank: Yeah? I don’t know. I’m not sure. I um, I think I did a over x plus b equals one x. 

13. Teacher: a over x plus b? 

14. Student #1: That’s not a linear function. 

15. Teacher: It’s not a linear function?  

16. Frank: No. 

17. Student #2: Because the y isn’t a line. It’s a curved line. 

18. Teacher: Ok, 30 seconds in your group. So he’s doing a divided by x plus b, right? Thirty seconds in 
your group. Why? What about the formula, what about the equation— 

19. Frank: The division. 

20. Teacher: Hold on. Ok, Frank, that may be true. But why? What about the formula makes it not linear? 
Or non-linear equation? Yeah, it’s division, but so what? Go ahead. Thirty seconds. What about it? 

46



 Reasoning and Sense-Making Question Stems   
TI PROFESSIONAL DEVELOPMENT 

 

©2013 Texas Instruments Incorporated 1 education.ti.com 

 

• Compare and contrast: How are they alike? How different? 

 

• Predict forward: “What would happen if … ?” 

 

• Predict backward: “How can I make ...  happen?” “Is it possible to ...?” 

 

• Analyze a connection/relationship: “When will ... be (larger, equal to, exactly twice, …) compared to 
...?”  “When will ... be as big as possible?” 

 

• Generalize/make conjectures:  “When does ... work?” “Under what conditions does … behave this 
way?”  “Describe how to find ...?” “Is this always true?” 

 

• Justify/prove mathematically:  “Why does ... work?” 

 

• Consider assumptions inherent in the problem and what would happen if they were changed 

 

• Interpret information, make/ justify conclusions: “The data support … ; “This … will make … happen 
because …” 
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Activity Overview 
View and discuss screen captures from students using TI-Nspire™ technology to explore The Pentagon 
Problem. 
 
 
 
 

   
Lexie Danielle Jacob 

   
Gia Brianna Andrew 

   
Rachel Pujan Brett 

   
Lila Tia Liyah 
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Sahil Kash Shreya 

   
Zach Carol Esther 

   
John Zoie Shelton 

   
Josh Seth Phong 
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pentagd'1hat you draw does not look like the one shown'when it is tumed in a different direction.)
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On the figure below, draw a different pentagon that has the same area as the one shown, {Be sure the
pentagon that you draw does not look like the one shown when it is turned in a diffurent direction.)

Explain how you know the pentagon you draw has thersame area as the one shown.
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On the figure below, draw a pentagon that has the same area as the one shown. (Be sure the
pentagon that you draw dOes not look like the one shown when it is turned in a different direction.)

EXptain hOw yoU know the pentagon you draw has the same area as the one shown.
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On the figure below, draw a different pentagon that has the same area as the one shown. (Be sure the
pentagon that you draw does not look like the one shown when it is turned in a different direction.)

Explain how you know the pentagon you draw has the same area as the one shown.
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On the figure below, draw a differenl pentagon that has the same area as the one shown. (Be sure the
pentagon thal you draw does not look ljke the one shown when it is turned in a different direciion,)
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On the figure below, draw a different pentagon that has the same area as the one shown. (Be sure the
pentagon that you draw does not look like the one shown when it is turned in a different direction.)

Explain how you know the pentagon you draw has the same area as the one shown.
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On the figure below, draw a different pentagon that has the same area as the one shown' (Be sure the

pentagori that you draw does not look like the one shown when it is turned in a different direction.)

Explain how you know the pentagon you draw has the same area as the one shown
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On the figure below, draw a different pentagon that has the same area as the one shown. (Be sure the
pentagon that you draw does not look like the one shown when ii is turned in a different direction.)

Explain how you know the pentagon you draw has the same area as the one shown.
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&" 1fu"w3
On the figure below, draw a $ff-q-1en-tp__e-rteg_o! that has the same area as the one shown. (Be sure the
pentagon that you draw does notlook like ihe one shown when it is turned in a different direction.)

Explain how you know the pentagon you draw has the same area as the one shown.
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= I *qnarc. Hc*t

On the figure belew., draw's differe{Tt pentagan ttlat has the s€me ar,ea:as the ons.shown, {Be s,ure.the
pentaE:nthat vnu draw does nert tsok tfke the one slrrwn wh.en it is tumed in a di.fferent.direetion.')

€xptain how y*u know tho penlagon you draw has the same srea as the. one shawn
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On the fig*re betow; dlgw q different pq:ntagsn that lrss the same, area a*'the'sne shown. {Be sure rtlxe

pgntagsn 'tttal:yoq drqw doeq no* look {iks ihe o*e, s}m$rn when lt is tumed in a differ'eni. directibn.)

exptaln how you linow the pen{agan ycu draw has the €anR,e ai:ea as lhe sne shown.
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= I sr.luare ilnit

On the figure below, draw a different pentagon that has the same area as the one shown. (Be sure the
pentagon that you draw does not look like the one shown when it is turned in a different direction.)

Explain how you know ihe pentagon you draw has the same area as the one shown.
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TI PROFESSIONAL DEVELOPMENT 

 

©2013 Texas Instruments Incorporated 1 education.ti.com 

Accessing Resources 

There are many resources for getting started with TI-Nspire™ technology at education.ti.com. 

 
Tutorials 
http://www.education.ti.com/tutorials TI has teamed with award-winning training providers Atomic 
Learning™ to create a library of product tutorials on TI technology. 

 

1. Once you have been directed to the Atomic Learning website, you can view short video tutorials 
on TI-Nspire™ handheld skills. Atomic Learning TI-Nspire Handheld skills include: 

• Using the CX keypad 

• Finding and opening a document 

• Graphing an equation 

• Tracing a graph 

• Entering data 

• Drawing shapes 

• And many more… 

2. To view the available tutorials for the TI-Nspire™ 
Navigator™ System, click on the “TI-Nspire Navigator” link 
on the Atomic Learning website. 

3. You will be directed to a list of short videos on TI-Nspire 
Navigator usage skills. Atomic Learning TI-Nspire Navigator 
skills include: 

• Creating a class 

• Starting a class session 

• Sending, collecting, and deleting documents 

• Using a Quick Poll 

• Using the Portfolio 

• Using Class Capture and Live Presenter 
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©2013 Texas Instruments Incorporated 2 education.ti.com 

Pre-Made Documents for Classroom Use 

4. Visit the Math Nspired Lesson Resource Center for Educators by 
visiting mathnspired.com. Here you can access a variety of 
Middle Grades Math, Algebra 1, Algebra 2, Geometry, 
Precalculus, Calculus, and Statistics activities for the classroom.  

Each subject is divided into units and lessons to assist 
teachers in locating activities on a specific concept. 

 

 
 

 

 

A variety of lessons can be found on the Math Nspired website, including: 

• Texas Instruments Action/Consequence lessons: Each lesson contains a TI-Nspire 
document where students take action on a math object, observe the consequence, and reflect 
on the math implications with the guidance of a student worksheet.  

• Texas Instruments “Create Your Own” Lessons: Each lesson guides you step-by-step 
through the creation of a TI-Nspire document and includes a one-page student activity. 

• Texas Instruments TI-Math.com: Features step-by-step instructions, student handouts, 
TI-Nspire documents (.tns), and a see-it-in-action video of the TI-Nspire document. 

• Shell Education TI-Nspire Strategies— Algebra/Geometry: Lessons move students from 
the concrete understanding of algebra concepts, through the abstract comprehension level, to 
a real-life application. 

• Brendan Kelly Publishing Algebra 1 & 2 with TI-Nspire—Semester 1 & 2: Ready-made 
lessons have complete keying sequences and detailed exercise solutions. 

• Dr. Daniel R. Ilaria – Enriching Mathematics: TI-Nspire & Calculus: Ready-made lessons 
and demonstrations for the Advanced Placement Calculus teacher. 

5. When a subject is selected, the channel expands and the various units become available. When a 
unit is selected, a table appears with an image from each activity.  

6. Each activity page shows math objectives, relevant vocabulary, and additional information about 
the lesson. A video offers a preview of the lesson, and related lessons are recommended. 
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7. Icons above the Download section allow you to recommend, 
save, email, and print an activity. Links to Facebook and 
Twitter are also available. The Download section contains links 
to activity files. Links for Standards and Textbook Alignment 
and relevant Tech Tip Videos are also available. 

 

8. Select the Standards Alignment link on the left. Select a set of 
standards from the drop-down box, and click View Standards. 
A list of performance/content standards appears for each 
grade, along with a list of the relevant strands and 
performance indicators.  

 

9. Select the Textbook Alignment link on the left. Select a textbook from the drop-down box, and click 
View Textbooks. A portion of the textbook’s table of contents appears, which identifies the relevant 
chapter, section, lesson, and page numbers for the selected Math Nspired lesson.  
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10. Visit TI Math at timath.com for a variety of classroom activities 
in the following subject areas: 

• Algebra 1 

• Algebra 2 

• Geometry 

• Precalculus 

• Calculus 

• Statistics 

 
 

 

Each activity has step-by-step instructions, a student handout, a TI-Nspire document, and a see-
it-in-action video of the TI-Nspire document. 

After you have decided on a subject area, be sure to change the device type to “TI-Nspire” and 
press FIND. 
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TI graphing calculators are permitted on  
important college entrance exams.
education.ti.com/go/testprep

*�SAT and AP are registered trademarks of the College Entrance Examination Board. PSAT/NMSQT is a registered trademark of the College Entrance Examination Board and National Merit Scholarship Corporation.  
IB is a registered trademark of the International Baccalaureate Organization. Praxis is a trademark of Education Testing Service. ACT is a registered trademark of ACT, Inc. None were involved in the production of nor do  
they endorse these products. Policies subject to change. Visit www.collegeboard.com, www.act.org and www.ibo.org.

TI presents, as accurately as possible, its current products and services, including hardware, software, screen shots and related support offerings. TI reserves the right to modify or discontinue products or services at any time  
without prior notice.

© 2013 Texas Instruments   CL1252

Testing agencies are responsible for respective testing dates; Texas Instruments is not responsible for any testing date changes.

TI-Nspire™ CX TI-Nspire™ TI-84 Plus 
Silver Edition

TI-84 Plus C
Silver Edition

TI-84 Plus TI-89 TitaniumTI-Nspire™ CX CAS TI-Nspire™ CAS

SAT*
AP*

ACT®*
IB®* Exam

Praxis™*

SAT
AP

SAT
AP

ACT
IB Exam

Praxis

SAT
AP

SAT
AP

ACT
IB Exam

Praxis

SAT
AP

ACT
IB Exam

Praxis

SAT
AP

ACT
IB Exam

Praxis

SAT
AP

TI-83 Plus

SAT
AP

ACT
IB Exam

Praxis

SAT*

7
DEC 2013

25
JAN 2014

2
NOV 2013

1
JUN 2013

5
OCT 2013

4
MAY 2013

8
MAR 2014

3
MAY 2014

For deadlines and registration, visit collegeboard.com/testing.

** These anticipated test dates are provided for planning purposes and are subject to 
final confirmation. The finalized, confirmed test dates, when announced, may differ 
from the dates shown.

** **

** **** **

AP*

10
MAY 2013

13
MAY 2013

8
MAY 2013

6
MAY 2013

StatisticsCalculus AB/BCChemistry Physics B/C

For deadlines and registration, visit apcentral.collegeboard.com.

9
MAY 2014

12
MAY 2014

7
MAY 2014

5
MAY 2014

StatisticsCalculus AB/BCChemistry Physics B/C

International Baccalaureate®* 
(IB) Exam/Praxis™*

For information on the IB test and test 
dates, visit ibo.org.

For information on the Praxis test and 
test dates, please visit ets.org/praxis.

ACT®*

26
OCT 2013

14
DEC 2013

21
SEP 2013

8
JUN 2013

14
JUN 2014

13
SEP 2014

12
APR 2014

8
FEB 2014

For deadlines and registration, visit act.org.

***�No test centers are scheduled in New York for the February test dates.

***
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